
 

1 Getting Started

 

This chapter introduces the basic steps involved in using NCSA Telnet for the Mac-
intosh Version 2.6:

• beginning an NCSA Telnet session

• opening and closing a connection

• copying, pasting, and printing the contents of session windows

• ending an NCSA Telnet session

It is assumed that you already know how to click and drag using the mouse, how to 
move and resize windows, and how to select items from menus. If you are unfamil-
iar with the Macintosh user interface or need additional information regarding 
these procedures, please refer to your Macintosh user’s guide.

 

Installation Note

 

This chapter assumes that your system or network administrator has already 
installed NCSA Telnet on your system, assigned an IP address to your Macintosh, 
and given you a login name and password for the computer to which you want to 
connect. For information regarding installation and customization procedures, see 
the second chapter (“Configuration” on page 2–1).

 

Beginning an NCSA Telnet Session

 

Invoke NCSA Telnet by double-clicking on the NCSA Telnet file or application icon. 
The NCSA Telnet application icon is shown below:

A box introducing NCSA Telnet appears on your screen, then disappears.

 



 

1-2

 

 

 

➢

 

 

 

NCSA Telnet for the Macintosh User’s Guide

 

Opening and Closing a Connection

 

Opening a Connection

 

To open a connection to a host:

1. Select 

 

Open Connection...

 

 from the 

 

File

 

 menu, which displays the 

 

Open Connection

 

 
dialog box:

2. Fill out the 

 

Open Connection

 

 dialog box. In the 

 

Host/Session Name

 

 box, enter the 
name of the host to which you want to connect. The session name can be any 
hostname, IP address, or alias. You may optionally append an alternate port 
number to connect to after the hostname, IP address, or alias. In the sample 

 

Open Connection

 

 dialog box below, the hostname is 

 

pluto

 

:

In the 

 

Window Name

 

 box, enter any name you wish for the connection’s window. 
This optional feature is not necessary with single connections but is very use-
ful when you open multiple connections. If you do not specify a window name, 
the connection’s window title is set to the contents of the 

 

Host/Session Name

 

 box 
and a number is appended.

3. If you want to connect as an FTP client, check the 

 

FTP Session

 

 box. For more 
information, see “Using an FTP Client” on page 4–2.

4. If you want to start an authenticated or encrypted connection, check the 

 

Authenticate

 

 box. 

 

Authenticate 

 

must be checked if you wish to use encryption. For 
more information, see “Authentication and Encryption” on page 3–5.

5. Click the 

 

Connect

 

 button, or press the RETURN key on your keyboard.



 

Getting Started

 

 ➢

 

 

 

1-3

 

NCSA Telnet attempts to connect to the host you specify, a process that generally 
takes only a few seconds. When a connection is established, a 

 

Connection

 

 window 
appears. The 

 

Window Name

 

 you specify in the 

 

Open Connection

 

 dialog box appears 
both in the title bar of the 

 

Connection

 

 window and in the 

 

Connections

 

 menu.

See the second chapter (“Configuration” on page 2–1) for alternative ways to open a 
connection, for session names other than the hostname, and for a discussion of 
aliases. For information about working with multiple sessions, see “Multiple Con-
nections” on page 3–1.

 

Logging on to Your Host

 

The 

 

Connection

 

 window indicates the name and type of your host machine and 
prompts you to enter your login name. For example, if you attempt to connect to a 
Sun system named 

 

pluto

 

, the login prompt may look like this:

 

SunOS UNIX (pluto)
login:

 

To log on:

1. Enter your login name at the login prompt and press RETURN. The host 
prompts you to enter your password.

2. Enter your password and press RETURN.

Now that you are logged on and running NCSA Telnet, your Macintosh operates as 
a VT102 or VT220 terminal that is remotely connected to the host.

 

NOTE: 

 

The response time of a host can vary. If the remote host is heavily loaded, a 
few minutes may elapse after the connection opens before the host prompts you to 
log on.

 

Setting the BACKSPACE/DELETE Key

 

NCSA Telnet automatically translates BACKSPACE/DELETE keypresses into 

 

delete

 

 
codes. This makes NCSA Telnet compatible with systems that prefer delete to back-
space. If your backspaces are not accepted, the host you are using may accept only 
backspace codes.

To test this possibility, select 

 

Backspace

 

 from the 

 

Session

 

 menu, which changes the 
setting of the BACKSPACE/DELETE key to backspace. This resets the default trans-
lation so that the key sends a backspace code. If your backspaces are now accepted, 
the host prefers backspace codes.

Change the setting of the BACKSPACE/DELETE key by selecting the desired key-
code (

 

Backspace

 

 or 

 

Delete

 

) from the 

 

Session

 

 menu. For more information regarding 
the configuration of the BACKSPACE/DELETE key, see “Editing Session Configura-
tion Records” on page 2–5.

 

Setting a VT Terminal Type

 

NCSA Telnet can emulate either a VT102 or a VT220 terminal. When you log on to a 
host, the host operating system does not always know what type of terminal you 
are using. For instructions on setting terminal type, consult the operating system 
manual for your host.

Try setting the terminal type to 

 

VT100

 

 or 

 

VT102

 

. Many UNIX and some other system 
do not support VT102. For such systems, set terminal type to 

 

VT100

 

 or 

 

tab132

 

 
(which is compatible with VT102 emulators).

The following examples demonstrate how to set the terminal type for two popular 
operating systems and hosts, UNIX (using the C shell) and VAX/VMS.
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For UNIX using a C shell and VT100 terminal type:

 

% 

 

set term=vt100;tset

 

For UNIX using a C shell and VT220 terminal type:

 

% 

 

set term=vt220;tset

 

For VAX/VMS:

 

B$ 

 

set term /inq

 

Emulating the VT Terminal Keyboard

 

Many keys are the same on both the Macintosh and VT keyboards. These key-
strokes are transmitted by NCSA Telnet without modification. However, the VT 
keyboard has some keys that the Macintosh keyboard does not have and also treats 
or labels other keys differently. In addition, many VT keys have special meanings 
when they are transferred to the host.

You can use the Macintosh keyboard to provide full VT220 functionality. Note that 
the position of the Macintosh numeric keypad is identical to that of the VT keypad, 
although the labels are different. If you are accustomed to using a VT keypad, you 
can ignore the Macintosh labels and enter as usual on the VT keypad. 

Macintosh key commands that correspond to key commands on a VT terminal are 
listed below.

 

VT Keyboard            Macintosh Plus Keyboard     Apple Desktop Bus Keyboard

 

` (backquote)          

 

q

 

-` 

 

or 

 

 OPTION-` *         

 

q

 

-` 

 

or 

 

 OPTION-` *

ESC

 

1

 

                   `                           ESC 

 

or

 

 `

DELETE

 

2

 

                BACKSPACE                   DELETE 

 

or

 

 DEL

BACKSPACE

 

2

 

             OPTION-BACKSPACE 

 

 

 

          OPTION-DELETE
LINE FEED              CONTROL-J                   CONTROL-J
PF1                    CLEAR on keypad             CLEAR on keypad
PF2                    / on keypad                 / on keypad 
PF3                    = on keypad                 = on keypad
PF4                    * on keypad                 * on keypad
CONTROL-SPACEBAR(NUL)  OPTION-SPACEBAR             CONTROL-SPACEBAR
Keypad keys            Keypad keys                 Keypad keys

* You must use 

 

q

 

-` if the 

 

Remap backquote to ESCape

 

 option is on.

 

1

 

 Use of ` as ESC is governed by how you set the 

 

Remap backquote to ESCape

 

 option in 
  the 

 

Global Preferences

 

 dialog box.

 

2

 

 See the BACKSPACE/DELETE key discussion in the section above.

 

For more information regarding NCSA Telnet’s emulation of VT terminals, see 
Appendix B (“VT Emulation” on page B–1) and Chapter 2 (“Configuration” on 
page 2–1). Appendix B also contains information about the mapping of VT220 
function keys.

 

Closing a Connection

 

To close a connection to your host, use the logout procedure specific to that 
system. On a UNIX system, for example, enter the UNIX 

 

logout

 

 command at the 
command-line prompt:

 

% 

 

logout
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If you cannot log out in this manner, select 

 

Close

 

 from the 

 

File

 

 menu. A 

 

Close Connec-
tion

 

 dialog box appears on the screen to confirm that you want to forcibly close the 
connection: 

Click on the 

 

OK

 

 button, or press the RETURN key. 

After you log out, the 

 

Close Connection

 

 window disappears. You can now safely quit 
the NCSA Telnet application.

 

Copying, Pasting, and Printing

 

NCSA Telnet lets you copy, paste, and print the contents of your session windows. 

 

Copy and Paste from the Edit Menu

 

First select (

 

highlight

 

) text in the window.

To 

 

copy

 

 highlighted text of a window 

 

as is

 

, choose 

 

Copy

 

 from the 

 

Edit

 

 menu.

To 

 

copy

 

 highlighted text of a window 

 

as a table

 

, choose 

 

Copy Table

 

 from the 

 

Edit

 

 
menu. White spaces in the highlighted text are replaced by tabs, according to the 
setting of the 

 

Copy Table threshold in the Global Preferences dialog box. You can paste 
the table into a word-processing program such as Microsoft Word or into a spread-
sheet program such as Microsoft Excel.

To paste the clipboard contents into a session window, choose Paste from the Edit 
menu.

NOTE: Copying and pasting are also discussed in Chapter 5, "Tektronix 4014 and 
4105 Emulation," and Chapter 6, "Interactive Color Raster Graphics." The Copy Table 
Threshold settings are discussed in the "Global Preferences" section of Chapter 2, 
"Configuration."

Print from the File Menu
First highlight the text you want to print.

To print highlighted text:

1. Choose Page Setup from the File menu, which opens the Page Setup dialog box.

2. In the Page Setup dialog box, specify the desired printing parameters, then click 
the OK button or press the RETURN key.

3. Choose Print Selection from the File menu. 

4. In the Print dialog box, specify the number of copies, printer, feed, and other 
parameters. Then click the OK button or press the RETURN key.

For more information regarding the Page Setup and Print dialog boxes, refer to your 
Macintosh user’s guide.



1-6 ➢ NCSA Telnet for the Macintosh User’s Guide

Ending an NCSA Telnet Session
To exit NCSA Telnet, select Quit from the File menu.

NOTE: You can quit NCSA Telnet any time during the program’s execution. How-
ever, you should, whenever possible, close connections to each system before quit-
ting NCSA Telnet to avoid loss of data or other complications. When you attempt to 
quit NCSA Telnet before closing current connections, a Close Connection dialog box 
appears to confirm that you want to forcibly close the connections. If you do, click 
the OK button or press the RETURN key; if you do not want to forcibly close connec-
tions, click the Cancel button.



 

2 Configuration

 

NCSA Telnet for the Macintosh allows you to customize the environment to suit 
special needs and habits. Version 2.6 of NCSA Telnet for the Macintosh uses an 
entirely new configuration system. This chapter describes global preferences you 
can set, the new configuration system, saved sets, and macro definitions.

For information about configuring file-transfer services, see “Configuring an FTP 
Server” on page 4–3.

 

Global Preferences

 

Several preference options affect every session or the operation of NCSA Telnet in 
general. You can set these options to best suit your environment and work habits. 

To set your global preferences, select 

 

Preferences

 

f

 

Global

 

 from the 

 

Edit

 

 menu. The  

 

Global Preferences

 

 dialog box appears:

Each option in this dialog box is described below.

 

Option Description

 

Command Keys

 

When you check this box, the menus are configured to accept com-
mand key equivalents.

 

NOTE:

 

 If the 

 

Command Keys

 

 box is not checked and if NCSA Telnet is 
running on a Macintosh that has no CONTROL key, the 

 

q

 

 key remaps 
to the CONTROL key. If the 

 

Command Keys

 

 box is checked on such 
machines, you cannot generate CONTROL key characters.

 

Remap backquote to ESCape

 

When you check this box, NCSA Telnet sends the ESCape character to 
the remote host when you press the grave accent (

 

`

 

). (This key is some-
times called the backquote.) This setting is helpful if you use an origi-
nal Macintosh or Macintosh Plus keyboard.

This option, however, is available no matter which type of keyboard 
you have. Pressing 

 

q

 

-` always produces a grave accent, regardless of 
whether you check 

 

Remap backquote to ESCape

 

 in the 

 

Global Preferences

 

 
dialog box.
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Copy Table threshold

 

The number you enter in this box determines the minimum number of 
spaces that are replaced by tabs when you use the 

 

copy table

 

 com-
mand instead of the standard 

 

copy

 

 command. You can select 

 

Copy 
Table

 

 from the 

 

Edit

 

 menu (or press 

 

q

 

-T) to copy a table from the NCSA 
Telnet screen onto the clipboard.

When you select

 

 Copy Table

 

 from the 

 

Edit

 

 menu, all strings of contiguous 
spaces greater than the threshold are turned into tabs before being 
placed on the clipboard. This produces a format you can paste into 
most spreadsheet and graphing programs without losing data or doing 
additional formatting.

 

Timeslice

 

The number you enter in this box determines how much time NCSA 
Telnet gives to other applications that may be running. Increasing this 
number reduces NCSA Telnet’s responsiveness but improves the per-
formance of applications running in the background. The number you 
enter is measured in sixtieths of a second.

 

Windows don’t go away

 

When you check this box, session windows remain open after their 
associated connections have terminated. The window title is placed in 
parentheses to signify that the associated connection has closed. You 
can view, copy, and print text in a window whose connection has been 
closed. You can also read connection error messages from hosts that—
due to an error—may close connections immediately after they are 
established. 

To close such a window, either click in the window’s close box or select 

 

Close

 

 from the 

 

File

 

 menu.

 

Staggered Windows

 

When you check this box, multiple windows are staggered by a whole 
title bar. This lets you see each window’s title. If this box is not 
checked, each new window is staggered by only a few pixels.

 

Blink Cursor

 

When you check this box, NCSA Telnet makes the cursor blink periodi-
cally in session windows.

 

Block, Underline, Vertical Bar

 

You can choose the appearance of the cursor in session windows by 
clicking the appropriate button: 

 

Block

 

, 

 

Underline

 

, or 

 

Vertical Bar

 

.

 

Capture File Creator

 

Enter an appropriate four-letter creator type in this box to specify the 
creator type assigned to the files in which NCSA Telnet saves text cap-
tured from sessions. Every Macintosh file has a file type and a file cre-
ator type. The 

 

file type 

 

specifies the type of file (e.g., text, word 
processing document, saved set). The 

 

file creator type

 

 tells the Finder 
which application to launch when you double-click on a filename. 

If you already know the four-letter creator type for the application you 
want to specify, enter it in the

 

 Capture File Creator

 

 box. If you do not 
know the four-letter creator type, click the 

 

Select Application

 

 button in 
the 

 

Global Preferences

 

 dialog box. This opens a standard 

 

Open File

 

 dialog 
box. Double-click on the name of the application whose creator type 
you want to find. NCSA Telnet then enters the four-letter creator type 
in the 

 

Capture File Creator

 

 box.
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New Configuration System in Version 2.6

 

Version 2.6 of NCSA Telnet for the Macintosh uses an entirely new configuration 
system. Earlier versions required an external text file named 

 

config.tel

 

, which 
contained keywords that specified the user’s preferences. The configuration sys-
tem for Version 2.6 is entirely graphical and does not require any external user-
editable files.

Ideally, all configuration options for a connection would be combined into one 
entity. However, due to the large number of options for each connection, NCSA Tel-
net connection options are divided into two parts: a terminal configuration record 
and a session configuration record. The 

 

terminal configuration record

 

 contains the 
options that pertain primarily to NCSA Telnet’s terminal emulation. The 

 

session 
configuration record

 

 contains the remaining options. 

Each session configuration record has a terminal configuration record associated 
with it. You determine which terminal record is associated with a given session 
record.

 

Default Configuration Records

 

Reasonable default terminal and session configuration records are set when you 
launch NCSA Telnet for the first time. Although you can change the preferences in 
these defaults, you cannot delete the default configuration records.

The default terminal configuration record and default session configuration record 
are used when you enter a hostname in an 

 

Open Connection

 

 dialog box. The prefer-
ences contained in the default configuration records are used as the defaults for 
any connection that does not have a preconfigured session or terminal record. The 
default records are also used to set the initial values of any new terminal or session 
configuration records you may define.

 

Editing Configuration Records

 

When you select either 

 

Preferences

 

f

 

Terminal

 

 or 

 

Preferences

 

f

 

Session

 

 from the 

 

Edit

 

 
menu, a 

 

Preferences

 

 dialog box appears similar to this one:

To add a new terminal or session configuration record, click the 

 

New

 

 button. To 
change an existing terminal or session record, click the 

 

Change

 

 button. To remove 
an existing terminal or session record, click the 

 

Remove

 

 button. You cannot remove 
the default.
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Editing Terminal Configuration Records

 

When you click either 

 

New

 

 or 

 

Change

 

 in the 

 

Preferences

 

 dialog box, the 

 

Terminal Config-
uration Record

 

 dialog box appears: 

 

Option Description

 

Terminal Name

 

The terminal name you enter here is listed along with your other termi-
nal configuration records in the 

 

Terminal

 

 popup menu of the 

 

Session 
Configuration Record

 

 dialog box. 

When you edit the default terminal configuration record, the 

 

Terminal 
Name

 

 field is hidden because you cannot rename the default record.

 

Xterm sequences

 

When you check this box, NCSA Telnet recognizes the Xterm escape 
sequences for changing window and icon titles. NCSA Telnet changes 
the title of the session’s window in response to those sequences.

 

Use VT wrap mode

 

When you check this box, NCSA Telnet sets the VT emulator to use 
autowrap mode by default.

The VT terminal maintains an internal setting to determine whether 
characters printed off the right-hand side of the screen cause the ter-
minal to wrap. If you set the terminal to wrap, new characters appear 
on the next line of the screen and the screen  scrolls as necessary. If 
you disable wrap mode, each new character replaces the last character 
on the current line and the cursor moves neither right nor onto the 
next line. 

 

NOTE: 

 

Any time you select 

 

Reset Terminal

 

 from the 

 

Session

 

 menu, wrap 
mode is disabled.

 

EMACS arrow keys

 

When you check this box, pressing your keyboard’s arrow keys sends 
the appropriate control codes for moving around in the EMACS editor. 
When this box is not checked, NCSA Telnet sends the VT codes for the 
arrow keys. This option also affects the codes sent when you you use 
the optional mouseclick feature. For more information, see “Cursor 
Positioning with the Mouse” on page 3–1.
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Map PgUp, etc.

 

When you check this box, NCSA Telnet uses the PAGE UP, PAGE DOWN, 
HOME, and END keys to change position in the session’s scrollback 
buffer (instead of sending the VT control codes for these keys to the 
remote host).

 

Eight bit connections

 

When you check this box, NCSA Telnet does not strip out the eighth bit 
from the data it receives. If you do not check this box, only the first 
eight bits are retained and all other incoming data are stripped out.

 

Save cleared lines

 

When you check this box, any time a VT clear-screen code is received 
NCSA Telnet saves the screen in the scrollback buffer before clearing 
the screen. If you do not check this box, all data on the screen are lost.

 

CNTL-COMND is EMACS meta

 

When you check this box, pressing CONTROL-COMMAND-

 

anykey 

 

is 
equivalent to pressing META-

 

anykey

 

 on a keyboard with a META key. 
This option does not send META CONTROL keystrokes because the 
CONTROL key is needed to activate such a  sequence. In future ver-
sions of NCSA Telnet, this option will be changed to better simulate 
META key sequences.

 

Emulation

 

Selecting the 

 

VT100

 

 or 

 

VT220

 

 button activates VT100 or VT220 emula-
tion, respectively, for this connection.

 

Font

 

Use the two boxes after 

 

Font

 

 to specify the font and font size used in 
this connection.

 

Scrollback

 

In this box enter the number of lines you want in the scrollback buffer.

 

Screen Width, Screen Height

 

 In these boxes enter the initial size of the VT emulation screen.

 

Screen Colors

 

This option is visible only on color-equipped Macintosh computers. 
Four boxes in the right-hand column (

 

Normal foreground

 

, 

 

Normal back-
ground

 

, 

 

Blinking foreground

 

, and 

 

Blinking background

 

) let you set the fore-
ground and background colors for the normal and blinking text 
modes. Clicking on any of the four boxes opens the standard 

 

Color 
Wheel

 

 dialog box in which boxes are filled with the current color selec-
tion. For additional information on using the 

 

Color Wheel

 

 dialog box, 
refer to the 

 

Macintosh System Software User’s Guide

 

.

 

Answerback Message

 

In this box specify the type of terminal you are using. NCSA Telnet 
sends this text to a remote host that asks the terminal type being used.  
The defaults are correct for almost all known systems.

 

Editing Session Configuration Records

 

Because the session configuration record is consulted only when NCSA Telnet ini-
tiates a connection, changes you make in the session configuration record affect 
only new connections initiated after your change. Think of it as your favorite 
cookie recipe: if you change the recipe today by adding nuts and chocolate chips, 
the cookies you baked last week are not affected.
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When you click either 

 

New or Change in the Preferences dialog box, the Session Configu-
ration Record dialog box appears:

Option Description

Alias In this box enter the name (alias) of the session configuration record. 
Then, when you enter this alias in the Host/Session Name field of the 
Open Connection dialog box, NCSA Telnet uses this session configura-
tion record as well as terminal configuration record specified in the 
Terminal popup menu of the Session Configuration Record dialog box.

 NOTE: Spaces are not allowed in alias names.

When you edit the default session configuration record, the Alias field 
is disabled because you cannot rename default records.

Hostname In this box enter the name of the host to which you want to connect. 
This text is passed to the MacTCP Domain Name Resolver (DNR), which 
translates a host’s domain name into an IP address.

Port In this box enter the name of the port to which you want NCSA Telnet 
to attempt the connection to the remote machine.

TEK There are three choices for Tektronix emulation in NCSA Telnet. Inhibit 
prevents NCSA Telnet from using any Tektronix emulation for this ses-
sion. 4014 and 4105 select Tektronix 4014 emulation or Tektronix 4105 
emulation, respectively.

Paste Method NCSA Telnet offers two different methods for pasting data into a ses-
sion. When you select the Quick button, NCSA Telnet sends all data to 
be pasted to the remote host at one time. The Quick method works 
well for small amounts of text and for sessions involving hosts that are 
close to you on the network. When you select the Block button, NCSA 
Telnet sends data to be pasted to the remote host in sections, or 
blocks, of text. The size of the block is determined by the number you 
enter in the box next to the Block button. Use the Block paste method 
when you need to paste large amounts of text or when you are con-
nected to a machine that responds slowly. 
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Delete Sends Some hosts expect the keyboard’s  DELETE character to delete, others 
expect it to  backspace. Select the Delete or Backspace button to deter-
mine which character NCSA Telnet sends to the remote host when you 
press the DELETE key.

Forcesave When you check this box, NCSA Telnet always saves the contents of 
the screen to the scrollback buffer. This option is available only to 
users of full-screen VMS environments, such as DEC All-in-One.

Berkeley 4.3 CR Mode When you check this box, you enable a special compatibility option for 
4.3 BSD UNIX. There is an official UNIX bug fix for this problem, but 
some hosts may still want CR-NULL used as the end-of-line character.

Allow linemode When you check this box, NCSA Telnet uses linemode with hosts that 
support it. If this option is not checked, NCSA Telnet refuses to use 
linemode.

TEK page clears screen When you check this box, NCSA Telnet’s Tektronix emulation clears 
the current Tektronix window any time it receives a Tektronix clear 
screen command. If you do not check this box, NCSA Telnet creates a 
new window for the new Tektronix image. Each new screen created 
this way takes the session name and time as its name. For more infor-
mation regarding the Tektronix clear screen command, see “Tek-
tronix-Related Commands in the Session Menu” on page 5–2.

Half duplex This option applies only to hosts that negotiate nonechoing mode but 
do not expect local line editing. If you check this box, all character keys 
are sent and echo to the screen immediately. If you do not check this 
box, characters echo locally and are queued until you press the 
RETURN or CONTROL key. This option has no effect when the local 
echo option is turned off.

Show low level errors When you check this box, NCSA Telnet displays minor error conditions 
it normally does not. These error messages can be helpful when you 
are trying to diagnose a problem with NCSA Telnet.

Authenticate When you check this box, NCSA Telnet tries to negotiate a Kerberos-
authenticated connection to the remote host, if the remote host sup-
ports authentication and if your Macintosh is properly configured. For 
more information regarding authentication, see “Authentication and 
Encryption” on page 3–5.

Encrypt When you check this box, NCSA Telnet tries to negotiate an encrypted  
connection to the remote host, if the remote host supports authentica-
tion and if your Macintosh is properly configured. For more informa-
tion regarding encryption, see “Authentication and Encryption” on 
page 3–5.

NOTE:  You must have an authenticated connection to use encryption.

Interrupt, Suspend, Resume NCSA Telnet uses certain key combinations for the interrupt, sus-
pend, and resume commands. Default key assignments for these com-
mands correspond to the standard ASCII characters. These three 
commands and their default key assignments are:

Interrupt.  Interrupt (CONTROL-C) sends a telnet interrupt process 
character that is equivalent to selecting Send "Interrupt Process" from the 
Network menu (see “Network-Related Commands” on page 3–4). The 
host’s implementation of telnet is required to listen for and interrupt 
the current application when this function is received.
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Interrupt also does a timing-mark operation (also known as timing-
mark flush and timing-mark processing). In many other implementa-
tions of telnet, pressing CONTROL-C can result in a several-minute 
delay while text scrolls on the  screen. This occurs because the TCP 
protocol has buffered up to 16 Kbytes or even 32 Kbytes of data, which 
are waiting in the pipeline to be delivered even before you press CON-
TROL-C. To avoid this scrolling of buffered data, NCSA Telnet initiates 
a process known as timing-mark flush any time you issue an Inter-
rupt command.

To do this, NCSA Telnet institutes timing-mark processing by sending 
to the host a special character that the host echoes back. The session 
appears to pause for up to 15 seconds and then resumes as usual. Dur-
ing the pause, NCSA Telnet throws away all buffered data. You end up 
pausing a few seconds instead of waiting several minutes. 

Suspend.  Suspend (CONTROL-S) instantly interrupts all output from 
the network. The current session does not produce any more charac-
ters on the screen until you issue the Resume command.

Resume.  Resume (CONTROL-Q) restarts character printing to the cur-
rent session. Resume does nothing unless a Suspend command is in 
effect.

Terminal This box contains a popup menu that lets you choose which terminal 
configuration record will be used when the alias identifying this ses-
sion configuration record is used to open a session.

Translation Table This box contains a popup menu that lets you choose which transla-
tion table will be initially selected for this session.
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Changing Configuration after Session Connected
Use the Session menu if you need to change configuration parameters after a ses-
sion connection is opened. Think of the Session menu as table salt: you use the salt 
shaker to change food at the table after it’s too late to go back to the kitchen and fix 
what you started with.

Command Description

Backspace When you select the Backspace command, pressing the DELETE key 
sends a backspace character.

Delete When you select the Delete command, pressing the DELETE key sends a 
delete character.

Local Echo When you select the Local Echo command, NCSA Telnet operates in 
local echo mode (characters are copied to the screen as soon as you 
press them on the keyboard). If you have not checkedAllow linemode (see 
“Editing Session Configuration Records” on page 2–5), NCSA Telnet 
can operate in two different echo modes: local and remote.  In remote 
echo mode, characters are sent to the host, which sends them back to 
be printed to the screen. 

Wrap Mode Selecting the Wrap Mode command turns on the wrap mode of the VT 
terminal emulator. When this command is not checked, wrap mode is 
disabled. See also the Use VT wrap mode option in “Editing Terminal Con-
figuration Records” on page 2–4.

EMACS arrow mapping When you select this command, pressing arrow keys on your keyboard 
sends the appropriate codes to move around in the EMACS editor. 
When the EMACS arrow mapping command is not checked, NCSA Telnet 
sends the VT codes for the arrow keys.
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Map PgUp/PgDown/Home/End When you select this command, NCSA Telnet uses the PAGE UP, PAGE 
DOWN, HOME, and END keys to move around in the session’s scroll-
back buffer. When the Map PgUp/PgDown/Home/End command is not 
checked, NCSA Telnet sends the VT codes for these keys.

Translationf The Translationf command opens a submenu that lets you choose the 
translation table for the session. In the sample below, no translation is 
desired.

Clear Screen Saves Lines When you select this command, all lines currently displayed on the 
screen scroll into the scrollback region before the screen is cleared. If 
Clear Screen Saves Lines is not checked, the cleared lines are perma-
nently erased when the screen is cleared. 

Reset Terminal When you select the Reset Terminal command, NCSA Telnet resets all VT 
mode settings, disables wrap mode, resets VT graphics mode, resets 
the keypad mode to the default, and resets tabs to every eight spaces. 
Use this command, for example, when a host program accidentally 
sets VT graphics mode or fails to leave VT graphics mode. 

Jump Scroll Select the Jump Scroll command if you want to skip to the end of the 
local buffer. The screen pauses, then jumps ahead over scrolling text. 
The text is placed into the scrollback buffer, but the screen advances 
to the end of the local network buffer instead of printing every line on 
the screen. The purpose of this feature is to save time. For example, if 
you enter a command that produces a great deal of output, you can 
use the Jump Scroll command so you do not have to wait for the output 
to scroll by.

TEK Page... When you select the TEK Page... command, you can quickly create or 
clear a Tektronix emulation window without intervention from host soft-
ware. Normally the emulation window appears automatically when the 
clear screen command sequence is received from the host, but the 
TEK Page... command creates the window immediately. 

To clear the current session window, use the TEK Page... command the 
same way you use the PAGE key on a Tektronix terminal. 

The TEK Page command is disabled when you select Inhibit as the TEK 
Emulation in the session configuration record that creates this ses-
sion. 

For more information, see the description of TEK options in “Editing 
Session Configuration Records” on page 2–5. See also “Starting a Tek-
tronix Emulation” on page 5–1 and “Tektronix-Related Commands in 
the Session Menu” on page 5–2.

TEK form feed clears screen When you select this command, NCSA Telnet’s TEK emulation does not 
clear the screen when it encounters a form-feed command. TEK images 
often conclude with a form feed command so that the TEK screen 
clears as soon as it reaches the end of an image. However, immediately 
clearing the screen makes it hard to see the final image of a TEK file. 
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Set Screen Size... Select this command to change the size of the VT emulation screen. 
NCSA Telnet’s VT emulation screens defaults to 24 lines because an 
actual VT terminal screen has room for 24 lines of text. Some host sys-
tems let you define a VT-like terminal type with more or fewer than 24 
lines. You can change the NCSA Telnet VT emulation screen default by 
editing the terminal configuration record. See the description of the 
Screen Width and Screen Height options in “Editing Terminal Configura-
tion Records” on page 2–4.

How to Reset Screen Size.  If you change the size of the VT emulation 
screen, the session window  resizes itself to reveal the entire VT 
screen. To increase or decrease the size of the VT emulation screen 
from the Session menu:

First select Set Screen Size... from the Session menu. The Select Screen 
Dimensions dialog box appears, showing the current number of lines 
and columns in the VT emulation screen.

Change the values as desired, then click the OK button (or press the 
RETURN key) to return to your session window.  Click the Cancel button 
to abort the change.

Shortcut to Reset Screen Size.  To quickly change the size of the VT emula-
tion screen, hold down the  OPTION key while you use the size box to 
resize the window. As the window changes size, NCSA Telnet recalcu-
lates the number of lines in the window and displays the current 
dimensions in the upper-left corner of the window. When you release 
the mouse button, the new size of the VT emulation screen is set. This 
method is equivalent to selecting Set Screen Size from the Session menu. 

NOTE: Resizing a session window without holding down the OPTION 
key only resizes the Macintosh window and does not change the size 
of the VT emulation screen.

Warnings and Suggestions.  If you do not have a good working knowledge 
of how your host system uses terminals with more than 24 lines, we 
recommend that you use only 24-line windows. The following warn-
ings and suggestions assume that you are familiar with UNIX-based 
software to control the number of lines for the terminal. Consult your 
host system documentation or system administrator for more infor-
mation.

The termcap file, which is found only in UNIX systems, is commonly 
located in the /etc/termcap file. It can be set up to include the num-
ber of lines on the terminal. The default VT100 termcap file explicitly 
sets a 24-line window, so even if you enlarge your NCSA Telnet win-
dow, the host uses only the top 24 lines. You can create special term-
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cap entries by editing the /etc/termcap file; copy the VT100 entry to 
a new name and change the number of lines to your preferred screen 
size.

Berkeley UNIX-based systems have a special feature in the stty pro-
gram. The number of rows in a session window can be set to any value, 
and applications programs such as vi learn your window size from the 
stty setting. To set the window size to 33 lines, enter stty rows 33.

You can use the special macro variable # to create a macro that issues 
this command and automatically substitutes the number of lines for 
the current window. For example, you could define the macro for q-0 
as stty rows \#. Now you can reset the window size by pressing q-0, 
then RETURN. The sequence \# is replaced with the proper number of 
lines. For information about creating and saving macros, see “Macro 
Definitions” on page 2–15.

Some systems have a program installed called resize. The resize pro-
gram sends a special sequence of VT control characters to NCSA Tel-
net’s VT emulator to determine the size of the screen. If resize is 
available on your system, adding resize > /dev/null to your 
.cshrc or .login file automatically sets your screen size correctly 
when you log on. To determine if the resize program is available at 
your site and for help using it, contact your system administrator.

NAWS (Negotiations About Window Size).  NAWS is a relatively new option in 
the telnet standard. UNIX hosts that support NAWS allow NCSA Telnet 
to send information to the host regarding the VT window size. Conse-
quently, when you select Set Screen Size... from the Session menu to 
change the VT screen size , the new screen size is sent over the net-
work to the host and you do not need to use the stty program. The 
host knows how big the window is, which eliminates possible prob-
lems for screen-oriented applications such as the vi editor. 

NOTE: NAWS is not supported by all UNIX machines. You can deter-
mine if the host you are connected to supports NAWS by changing the 
size of the VT emulation screen and then asking the remote host for 
the screen size. If the host responds with a screen size that matches 
the new screen size you have just set, the host supports NAWS.

Setup Keys... Use the Setup Keys... command to select which keys, if any, issue the tel-
net commands interrupt, suspend, and resume. See the description 
of the Interrupt, Suspend, Resume options in“Editing Session Configura-
tion Records” on page 2–5.

Font f The Fontf command opens a submenu containing the fonts you can 
use to display text in a session window. When you select a font from 
this submenu, the current window is resized to contain the text and 
the selected font is used to display all text in the current window.

NOTE: Proportionally spaced fonts—which include most fonts except 
Courier and Monaco—display slowly and appear spread out.

Size f The Sizef command opens a submenu that contains the point sizes 
you can use to display text in a session window. The submenu lists 
several sizes, checks the current size, and outlines all sizes in your 
system. When you select a point size from this submenu, the current 
window is resized to contain all the resized text and the text is 
redrawn according to the specified point size.
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NOTE: Sizes that are not outlined in the submenu must be scaled by 
the system software and therefore may be slow and less sharply 
defined than nonscaled point sizes.

Color... The Color... command applies only to Macintosh computers that are 
color-equipped. To change the foreground and background colors of 
the current window for both normal text and blinking text: 

First select Color... from the Session menu. The Color Selection dialog box 
appears:

Then click the box next to the item to which you wish to assign a color: 
Normal Text, Normal Background, Blinking Text, or Blinking Background. This 
opens the Color Wheel dialog box. Select a new color by clicking in the 
color wheel. The color you select appears in the top rectangle under 
the heading Please Select New Color. Click OK (or press the RETURN key) 
to set the color change and return to the Color Selection dialog box. The 
box next to the item you selected in Step 2 reflects the color you chose 
from the Color Wheel dialog box. Repeat to assign colors to other items 
in the Color Selection dialog box. Click OK when you are done choosing 
colors. The new colors are applied to your current session window.

For additional information on using the Color Wheel dialog box, refer to 
your Macintosh System Software User’s Guide.

Capture Session to File NCSA Telnet can save the text from a session to a file. When you select 
thiscommand, all normal text output that appears on the screen is also 
saved to whatever file you specify in the Save File dialog box. When the 
Capture Session to File command is not checked, this functionality is 
turned off.

Saved Sets
NCSA Telnet makes it easy for you to begin multiple sessions quickly. If you use 
saved sets, you can log on and get right to work without resetting the special char-
acteristics and configuration of a connection each time you start up.

A set—a snapshot of open sessions and their current configurations—consists of 
current macro settings and each session’s window location and size, connected 
host, window name, scrollback setting, color, font, font size, backspace/delete set-
tings, and all other configuration information.
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Saving a Set
To save a set:

1. Log on to the desired host as instructed in “Logging on to Your Host” on 
page 1–3.

2. Customize the session by moving the session window to an ideal location on 
the screen, specifying a background or text color, choosing a font and font 
size, setting the desired number of scrollback lines, and choosing the function 
for the BACKSPACE/DELETE key.

3. Select Save Set from the File menu. 

4. A File dialog box appears and prompts you to name the set. 

5. After naming the set, click on the Save button in the dialog box to save the set.

Using a Saved Set
Saved sets let you bypass the start-up procedure described in “Opening and Clos-
ing a Connection” on page 1–2. Specifically, you do not need to select Open Connec-
tion from the File menu (or press q-O) or to specify the connection host or window 
name. These operations are performed automatically when you load a set.

After you load a set, the session window automatically appears for the specified 
host at the specified location on the screen and with the specified window name, 
scrollback setting, color and other characteristics. The following characteristics are 
saved in a set:

• Session name

• Hostname

• Port number

• Window size and location

• Scrollback setting

• BACKSPACE/DELETE key setting

• Macro definitions

• Command-key setting

• Number of columns

• Tek clear-screen setting

• Font and font size

• Color characteristics

• Assigned keys for Interrupt, Suspend, and Resume functions

• CRMAP setting

• Linemode setting

• Eight-bit status

• Translation table setting

• TEK emulation setting

• Answerback message
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Loading a Saved Set

From the Finder
To load a set from the Finder and automatically invoke NCSA Telnet, double-click 
on the saved-set icon or filename. The sample below shows the saved-set icon for a 
set named Setup One. 

From within NCSA Telnet
To load a set from within the NCSA Telnet application, select Load Set from the File 
menu. In the File dialog box that appears, select and open the set.

NOTE: You can edit a set datafile using any editor capable of editing files, even if 
the datafile’s Macintosh file type is not TEXT. However, don’t rely on this feature 
because it may not work with future versions of NCSA Telnet.

Macro Definitions
NCSA Telnet lets you use the key combinations q-0 through q-9 as macro keys. 
You can program these keys to send from 0 to 255 characters.

To define a macro:

1. Select Set Macros from the Edit menu or press q-M. The Macro Configuration  dialog 
box below shows several sample macro definitions.

2. Click on the button of the command key you wish to define, or select the box 
next to that button.

3. Enter the appropriate macro key sequence. Unless you are familiar with the C 
programming language, the key sequences that generate special control char-
acters in a macro may seem somewhat strange. To define a special character, 
you must first enter a backslash (\). Indicate nontypable control characters 
with their equivalents in the octal numbering system. Some common macro 
key combinations you might want to enter are listed below.
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4. Click on the OK button (or press the RETURN key) to activate the new macros, 
or click on the Cancel button to invalidate the additions or changes you made. 
Clicking either OK or Cancel returns to the application.

Common Macro Key Combinations

Desired Character Definition

Backslash (\) \\

TAB \t

ESC \033

CONTROL-C \003

CONTROL-D \004

CONTROL-E \005

CONTROL-H or BACKSPACE \010

Size of current window \#     (Refers to setting the number of usable lines in a session win-
dow. See the Set Screen Size command described in “Changing Configu-
ration after Session Connected” on page 2–9.)

Internet address of this Mac \i     (See also the descriptions of the Show Network Numbers com-
mand in “Network-Related Commands” on page 3–4 and the Send IP 
Number command in step 3 of “Issue the FTP Command” on page 4–6.)

Reverting to Previous Macro Definitions
While you are working in the Macro Configuration dialog box, you can undo changes 
you made to a macro and also revert the associated command key to its previous 
setting—just click on the button corresponding to that command key. For example, 
to undo changes to the definition for q-2, click on the q2 button. To simulta-
neously abandon all changes you have made, click on the Cancel button.

Saving Macros
Currently the only way to save your macro settings is in a saved set. See “Saved 
Sets” on page 2–13. NCSA plans to extend the macro capability of NCSA Telnet in 
future versions.



 

3 Advanced Features

 

This chapter covers more advanced aspects of the working environment of NCSA 
Telnet for the Macintosh. It describes how to use the mouse to position the session 
cursor, open multiple connections, implement commands from the 

 

Connections

 

 and 

 

Network

 

 menus, and use authentication and encryption.

 

Cursor Positioning with the Mouse

 

You can use the mouse to position the session cursor if you are using a full-screen 
editor that supports the arrow keys. One such editor is vi. When the mouse cursor 
is in a session window, holding down the OPTION key changes the mouse cursor 
into a rectangle. When the mouse cursor is in the session window, holding down 
the OPTION key and simultaneously pressing the mouse button instructs NCSA 
Telnet to send a sequence of arrow keys to move to that position on the screen.

 

 

NOTE:

 

 If your editor is EMACS rather than vi, you should either set the 

 

EMACS arrow 
keys

 

 option in the session configuration record or check the 

 

EMACS arrow mapping

 

 
command in the 

 

Session

 

 menu

 

Multiple Connections

 

NCSA Telnet lets you use multiple connections, either to a single host or to several 
different hosts. 

 

Opening More Than One Connection

 

To open another connection, follow either the opening-a-connection procedure 
presented in “Opening and Closing a Connection” on page 1–2 or the saved-set 
instructions in “Loading a Saved Set” on page 2–15.

The 

 

active

 

 session is the connection with which you are currently working. The 
active session’s window is generally frontmost on your desktop.

 

Moving between Connections

 

To switch between sessions and to make a new session window your active session, 
bringing it to the front, either click on the session window for the desired connec-
tion or select the desired session name from the 

 

Connections

 

 menu.

To activate  the session window directly beneath the current session window, select 

 

Next Session

 

 from the 

 

Connections

 

 menu or press 

 

q

 

-N (for 

 

next

 

).
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NCSA Telnet opens new session windows on the screen relative to the number of 
windows currently opened. You can specify that these windows be staggered by 
just a few pixels or by the whole window title bar. See the description of the 

 

Stag-
gered Windows

 

 option in“Global Preferences” on page 2–1.

 

Rules for Session Names

 

When you open multiple connections to a single host, it is useful to specify session 
names (other than the hostname) for the connections. You may use any of the fol-
lowing for session names:

• the host’s full Internet address, such as 

 

192.17.22.20

 

• any session configuration record alias (see “Editing Session Configuration 
Records” on page 2–5)

• any name, such as 

 

sri-nic.arpa

 

, that can be resolved by the domain-based 
nameserver

 

NOTE: 

 

Some systems, such as MFENET, do not use the standard telnet port number 
23. If you need access via the telnet protocol to a different port number, in the 

 

Open 
Connection

 

 dialog box enter the port number after the session name; the session 
name and port number must be separated by one or more spaces. For example, to 
open a connection to port 23 of 

 

myhost.network.arpa

 

, in the 

 

Host/Session Name

 

 
box of the 

 

Open Connection

 

 dialog box, enter 

 

myhost.network.arpa

 

. To open a con-
nection to port number 911 of the same host, enter 

 

myhost.network.arpa 911

 

. 
You can also specify alternate port numbers in your session configuration records.

 

The Connections Menu

 

You can specify titles that are different from the session names for your session 
windows so that you can easily distinguish between multiple sessions and session 
windows.

 

Naming Windows

 

To specify a window title, enter the desired name in the 

 

Window Name

 

 box of the 

 

Open Connection

 

 dialog box.

 

NOTE: 

 

If the 

 

Window Name

 

 box is blank when you open a connection, NCSA Telnet 
automatically numbers the session. Each time you open a session, the number 
increases, no matter how many sessions are currently open.

 

Checking Session Status

 

The 

 

Connections

 

 menu contains the window names for current connections and the 
status of each session. A checkmark (

 

m

 

) next to a 

 

window

 

 name indicates an active 
session, and a diamond (

 

d

 

) or circle (•) next to a 

 

session

 

 name indicates an 
attempted connection that has not yet successfully opened. More specifically, a 
diamond indicates that NCSA Telnet is checking the nameserver to find the session 
name or hostname; a circle means NCSA Telnet is trying to open the session. Once 
the connection is established, the diamond or circle next to the session name goes 
away and the session window appears.
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NOTE: 

 

If you do not remember the meaning of these symbols, select 

 

Marked Connec-
tion

 

 from the 

 

Connections

 

 menu. The 

 

Connection Status

 

 dialog box then reports the 
name and status of the connection. After you read the message, click the 

 

OK

 

 button 
(or press RETURN) to proceed with opening the connection, or click the 

 

Abort

 

 button 
to cancel the attempt.

 

Aborting Connection Attempts

 

To abort an attempted connection attempt:

1. Select the desired connection from the 

 

Connections

 

 menu. The 

 

Connection Status 

 

dialog box appears, reporting the name and status of the connection.

2. Click the 

 

Abort

 

 button in the 

 

Connection Status

 

 dialog box.

 

Changing a Window Title

 

Select 

 

Change Window Title…

 

 from the 

 

Connections 

 

menu to change the window title of 
the frontmost window.

 

The Network Menu

 

NCSA Telnet supports several special commands defined by the Internet standard 
telnet protocol. Each host telnet implementation treats these commands differ-
ently, so they may have no effect on some hosts.

The 

 

Network

 

 menu includes seven telnet commands as well as two network-related 
commands:

 

Telnet Commands

 

Command Description

 

Send FTP Command

 

When you select this command, NCSA Telnet sends an FTP command 
to the remote machine. Normally the command is

 

 ftp 

 

w.x.y.z

 

 

 

(where

 

 

 

w.x.y.z

 

 is the IP address of your Macintosh) followed by a return char-
acter. However, if the FTP server is in anonymous mode, NCSA Telnet 
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sends the command 

 

ftp -n 

 

w.x.y.z

 

 followed by a return character. 
You can force NCSA Telnet to omit the 

 

-n

 

 option if you hold down the 
SHIFT key. For more information about FTP commands, see “File 
Transfer” on page 4–1.

 

Send IP Number

 

When you select this command, NCSA Telnet sends the IP address of 
the Macintosh you are using to the remote machine as if you typed it in 
manually.

 

Send "Are You There?"

 

Use this command whenever you are not sure whether the network 
and host are up. Every once in a while, especially when the host is bom-
barded with incoming information or tied up by a large number of 
users, the host doesn’t seem to respond to your commands. When this 
happens and your terminal appears to have locked up, you can select 
this command to determine whether you are still connected to the 
host. The host is supposed to respond, if able, with a readable mes-
sage. Some machines answer 

 

Yes

 

; others answer with more informa-
tive messages. 

 

Send "Abort Output"

 

This command is supposed to throw away all output from the current 
process and then resume when there is a pause. Very few hosts imple-
ment this command correctly.

 

Send "Interrupt Process"

 

Available on nearly every telnet host, this command stops the current 
process and throws away all pending data for the connection. It is 
equivalent to pressing CONTROL-C on most UNIX systems. You can set 
your Macintosh keyboard so that CONTROL-C sends the 

 

Send "Interrupt 
Process"

 

 command; select the 

 

Setup Keys...

 

 command in the 

 

Session

 

 
menu, as described in “Changing Configuration after Session Con-
nected” on page 2–9.

 

Send "Erase Character" 

 

and

 

 

Send "Erase Line"

 

You can erase either the last character or the current line by selecting 

 

Send "Erase Character"

 

 or 

 

Send "Erase Line"

 

, respectively. Many hosts do 
not implement these commands but use their own special characters 
instead.

 

Network-Related Commands

 

The 

 

Network

 

 menu includes two of NCSA Telnet’s network-related commands:

 

Command Description

 

Suspend Network

 

Select this command to temporarily suspend all network communica-
tions and disable all receive functions. All of your connections are kept 
alive, but you do not see any incoming text.

 

NOTE: 

 

Generally you should use the 

 

Suspend

 

 and 

 

Resume

 

 commands 
rather than the 

 

Suspend Network

 

 command. See the discussion of the 

 

Interrupt

 

, 

 

Suspend

 

, and 

 

Resume

 

 commands in “Editing Session Con-
figuration Records” on page 2–5.

 

Show Network Numbers

 

Because NCSA Telnet now uses MacTCP for all network communica-
tions, this command is largely unnecessary. However, for purposes of 
continuity, selecting this command displays your Macintosh’s IP 
address in a dialog box but does not transmit the address. Click on the 
dialog box to remove it.
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Authentication and Encryption

 

NCSA Telnet supports Kerberos Version 4 authentication (from Cornell University) 
and DES encryption.

Computer users traditionally have entered passwords to log on to their accounts 
on hosts. While passwords have provided some level of security, a proliferation of 
methods for snooping passwords off the Internet has greatly reduced the security 
provided by passwords.  

Kerberos provides a system that 

 

authenticates

 

 a user to hosts. After you enter your 
password once, that password is usedto gain a 

 

ticket from a Kerberos server. You 
use this ticket to log on to Kerberos-aware hosts without entering your password: 
the ticket guarantees that the person making the connection is who you say you are 
(i.e., because you are the authentic person,  you are authenticated). The method 
used to gain the ticket does not require that your password pass over the network 
in an easily snooped form.

Even with the authentication features of Kerberos, NCSA Telnet connections are 
still subject to snooping. Data you send and receive can be snatched from the net-
work and viewed by others. However, when NCSA Telnet sets up an encrypted con-
nection, data are scrambled before passing between your Macintosh and a remote 
host. Such data are significantly more protected than unencrypted data. Encryption 
is not foolproof, but it does stop the majority of attempts to snoop through your 
data.

NCSA Telnet requires that an authenticated connection be in place before using 
encryption.

Preparing Your Environment
NCSA Telnet uses Cornell University’s Kerberos driver package (Kdriver) for Ker-
beros and encryption support routines. Kdriver, which supports Kerberos Version 
4, requires that each Kerberos server host also  run a UDP daytime server. KConfig 
(an application written by Rick Watson of the University of Texas) is used to config-
ure Kdriver settings. 

You can download the Kerberos Client extension and the KConfig application 
from NCSA’s anonymous FTP server. (See “Anonymous FTP Server” on page C–1.) If 
you use a version of the Cornell Kerberos driver obtained from a source other than 
NCSA, encryption is not supported, some setting changes made by KConfig won’t 
be saved in the Preferences file, and the ticket may display garbage for the user 
realm.

You also need to know pertinent information regarding your site’s Kerberos server. 
If you are an administrator, you need to install a Kerberos server for your site.  
Installing a Kerberos server is beyond the scope of this manual.

NCSA Telnet for the Macintosh Version 2.6 supports the telnet authentication and 
encryption options described in the RFC1411/1416 and IETF drafts dated July 
1991. Future versions may support the IETF draft AUTH_ENCRYPT option 
described in the draft dated April 1993.

Installing Software
To implement either authentication or encryption, you must install Kdriver in the 
System folder on your Macintosh. Drag the Kerberos Client extension to your 
closed System Folder. If you are running System 7, you are asked to verify that the 
file is to be placed in your Extensions folder. 
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Reboot your Macintosh and use KConfig to configure settings for your Kerberos 
environment. All KConfig settings are made in the Kerberos Configuration window.

Mapping Kerberos Realms to IP Names
This section assumes you are familiar with Kerberos.

A domain/hostname-to-realm map attempts to match a Kerberos realm with IP 
domain names. Use KConfig  to set up domain/hostname-to-realm maps, which are 
useful if you support more than one Kerberos realm.

You may (or may not) have to reboot after entering your initial settings in the Ker-
beros Configuration dialog box.

Option Description

Domain/Hostname . . . Realm Enter the domain or host name for each Kerberos host you are using.

Server IP address . . . Realm Enter the Kerberos server’s IP address or hostname for each Kerberos 
realm you are using. After entering your Kerberos servers, you can 
pick your local realm using the Local Realm: popup menu at the top of 
this dialog box.

Login Click this button to authenticate to a Kerberos server and obtain an 
initial ticket-granting ticket for other services. You don’t have to log on 
using KConfig; NCSA Telnet prompts you when a password is needed.

Logout Click this button to destroy all tickets. Select Show Credentials from the 
File menu to display all your Kerberos tickets.

Change Password Click this button to change your Kerberos password.

Activating Authentication and Encryption in NCSA Telnet
Authentication and/or encryption options appear in two places in NCSA Telnet:

•  In the Open Connection dialog box. See “Opening a Connection” on page 1–2.

• In the Session Configuration Record dialog box. See “Editing Session Configuration 
Records” on page 2–5.
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In the Open Connection dialog box, you can select the Authenticate and Encrypt options 
when you open a session. These options apply to the default session. 

NOTE:  The Authenticate option is required for encryption. FTP sessions cannot cur-
rently be authenticated or encrypted.

In the Session Configuration Record dialog box, select the appropriate options for each 
session that you configure, including the default session. 

Indicating Active Encryption
NCSA Telnet displays encryption icons next to the zoom box in the window’s title 
bar. For example, see the padlock icon below:

A padlock icon indicates that a session is two-way encrypted, which means that 
data are encrypted both going to and coming from the server. If any other icon is 
displayed, the session is not two-way encrypted. An arrow indicates that the ses-
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sion is encrypted in one direction only—either boging to or coming from the 
server—and is probably evidence of a bug in either the NCSA Telnet code or in your 
telnet server. The absence of any icon means that no encryption is taking place.



 

4 File Transfer

 

This chapter discusses File Transfer Protocol (FTP) as well as various features of 
NCSA Telnet for the Macintosh for transferring Macintosh and other files.

 

File-Transfer Terminology

 

The following terms are frequently used in this chapter:

ASCII file An 

 

ASCII

 

, or 

 

text

 

, file is one that you can read. You can use it with 
standard editors on the Macintosh or host. When text files are 
transferred, they are translated to a format appropriate for the 
receiving machine.

Binary file A 

 

binary

 

, or 

 

image

 

, file cannot be read by standard text editors. 
Unlike ASCII text files, binary files are not changed in any way 
when transferred.

Client/server The 

 

client

 

 is the computer system that requests services, and the 

 

server

 

 is the system that provides services. 

The client is not always your Macintosh, despite appearances. 
When you use NCSA Telnet to connect to a host, your Macintosh is 
the telnet client. When you request a file transfer from your Macin-
tosh, the transfer is actually initiated on the host, making the host 
the FTP client and your Macintosh the FTP server. Your Macintosh 
can be both a telnet client and an FTP server at the same time.

File transfer In a 

 

file transfer

 

, the contents of a file are copied to a file on 
another computer.

MacBinary file A 

 

MacBinary file

 

 has been encoded in the MacBinary file format so 
it can be stored for downloading later to a Macintosh. Because the 
file contains all the information contained in a normal Macintosh 
file, a MacBinary file can be used for transferring applications and 
other Macintosh-specific files. MacBinary files are virtually useless 
on any other machine.

 

About FTP and NCSA Telnet

 

NCSA Telnet has an internal FTP server that permits reliable file transfers between 
a Macintosh and any FTP host on the network. File transfers are initiated from the 
FTP host. With the NCSA Telnet implementation of FTP, you can:

• Stream transferring files in either text (ASCII) or binary (image) format 

• Change the directory

• Show the name of the current directory

• List files in the current directory (with wildcard specifications)

• Send and receive multiple files with one command (using wildcards)
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File transfers are processed in the background. While a file transfer is in progress, 
you can perform other NCSA Telnet activities such as switching sessions, adding 
new sessions, or changing parameters. When one FTP connection is active, requests 
for another are ignored.

 

Using an FTP Client

 

NCSA Telnet lets you use an FTP client to connect directly to the FTP port of a host 
machine, which means you can transfer a file directly between the remote host and 
your Macintosh. 

This is simpler than the normal process, which requires you to log on to a UNIX 
account, transfer a file from the remote host to your UNIX account, and finally 
transfer the file from your UNIX account to your Macintosh.

When you use an FTP client to transfer files directly between a UNIX host and your 
Macintosh, you do not need to log on to a secondary UNIX account for FTP to use as 
a temporary go-between.

Follow these steps to log on to and use an FTP client: 

1. Select 

 

Open Connection

 

 from the 

 

File

 

 menu. The 

 

Open Connection

 

 dialog box 
appears.

2. In the 

 

Open Connection

 

 dialog box, check the 

 

FTP Session

 

 box. This opens a win-
dow displaying an FTP client connection message similar to the one below:

Checking the 

 

FTP Session

 

 box is exactly the same as opening a connection to a 
UNIX machine on port 21, which is the FTP port. Therefore, if you set up an 
alias to port 21 of a remost UNIX host, all sessions opened to that alias are FTP 
clients. For more information about aliases and session configuration records, 
see the description of the 

 

Alias

 

 option in “Editing Session Configuration 
Records” on page 2–5.

3. Enter 

 

user

 

 followed by your login name and press RETURN. Example:

 

user 

 

loginname

 

 RETURN 

4. The host prompts for your password. Enter your password and press RETURN.

5. If you are logged on successfully, the host sends a message that you are con-
nected properly.

Once logged on, use the FTP client just as you would normally use an FTP session.
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Configuring an FTP Server

 

To configure an FTP server, select 

 

Edit

 

f

 

FTP Server

 

 from the 

 

Preferences

 

 menu. The 

 

FTP Server Preferences

 

 dialog box appears:

Each option in this dialog box is described below.

 

Option Description

 

Server Mode

 

NCSA Telnet’s FTP server can operate in three modes: off, on with no 
passwords, and on with passwords. When you select 

 

Off

 

, NCSA Telnet 
refuses all FTP connections to your Macintosh. When you choose 

 

On, No 
passwords needed

 

, NCSA Telnet allows anyone to connect to your Macin-
tosh through FTP. When you select 

 

On, Username & Password required

 

, 
NCSA Telnet requires connecting users to supply a valid username and 
password before gaining access to your Macintosh through FTP.

 

WARNING:

 

 Do

 

 

 

not

 

 leave the FTP server in 

 

On, No passwords needed

 

. This 
mode allows 

 

anyone

 

 access to your entire filesystem. NCSA Telnet 
includes this mode merely for quick and simple file transfers. It is not 
appropriate for a permanent configuration setup.

For information regarding the configuration of usernames and pass-
words for FTP, see “Controlling Access” on page 4–4.

 

Show FTP log at startup

 

When you check this option, the FTP log is displayed when NCSA Tel-
net is launched. The FTP log shows current and past transactions:

 

Use Macbinary II

 

When you select this option, NCSA Telnet uses MacBinary transfer 
mode when in binary mode. You can turn MacBinary mode on and off 
either from this dialog box or by sending 

 

quote macb enable

 

 or 

 

quote macb disable

 

 to the FTP server.
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Reset Macbinary after each transfer

 

When you select this option, the MacBinary transfer mode returns to 
your preferred default (

 

enabled

 

 or 

 

disabled

 

) each time you open a new 
FTP session, regardless of how you set the mode in a previous session. 
This saves you the trouble of tracking whether Macbinary transfer 
mode is enabled each time you want to transfer files. 

 

NOTE: 

 

Each FTP session corresponds to the opening of each FTP com-
mand connection, not to the individual file transfer.

 

Use ISO Translation

 

When you select this option, filenames sent in directory listing to the 
connected FTP user are first translated into the International Stan-
dards Organization (ISO) character set.

 

Binary Filetype

 

 and 

 

Creator

 

Use the

 

 Binary Filetype

 

 and 

 

Creator

 

 boxes to specify the file type and file 
creator type for files transferred in binary mode when MacBinary 
transfer mode is disabled. Clicking on the 

 

Example

 

 button opens the 

 

File

 

 
dialog box; use the the dialog box to select a file, then determine that 
file’s file type and file creator type. For more information regarding 
file types and file creator types, see the discussion of the 

 

Capture File 
Creator

 

 option in “Global Preferences” on page 2–1.

 

Text Creator

 

Use the 

 

Text Creator

 

 box and

 

 Select Application

 

 button to select the four-
letter file creator type given to files transferred to your Macintosh 
through ASCII transfer mode.

 

Controlling Access

 

To control who has FTP access to your Macintosh, select 

 

Preferences

 

f

 

FTP Users

 

 from 
the  

 

Edit

 

 menu. An 

 

FTP Users Preferences

 

 dialog box appears that is similar to the fol-
lowing, which lists three users (jbrowne, melliott, and uldhmi):

Highlighting a username, then clicking on the 

 

Remove

 

 button cancels that user’s 
access privileges.
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Clicking on either the 

 

New

 

 or 

 

Change

 

 button  opens a dialog box similar to the one 
below, which lets you add a new FTP user or change information about an existing 
FTP user:

In this sample, the user receiving FTP access is 

 

jbrowne

 

, whose password is not 
displayed. When jbrowne logs on, his default directory will be 

 

/slot6drive1/

 

.

 

Option Description

 

Username

 

In this box enter the name you want NCSA Telnet to recognize at the 
username prompt.

 

Password

 

Enter the user’s password in this box. Newly entered passwords are 
displayed in normal text. When you change records, this box always 
displays eight bullets (•) regardless of the length of the actual pass-
word. Passwords are stored in an encrypted format in the preferences 
file. 

 

NOTE:

 

 The encryption method used on passwords is quite simple and 
prevents casual users from discovering your passwords. But you 
should never give anyone a copy of your 

 

Preferences

 

 file.

 

Default Directory

 

When a user logs on with the correct username and password, NCSA 
Telnet’s FTP server sets the working directory to the default, which is 
identified here. Clicking on the 

 

Change Default Directory

 

 button lets you 
change this user’s default directory.

 

Preparing to Transfer Files

 

Before you attempt to transfer files using FTP, make sure the following conditions 
are met:

• Your host system supports FTP file transfer. If you do not know whether it 
does, see your system administrator.

• You have not disabled the file transfer capability of NCSA Telnet. You can 
check two conditions to determine whether the FTP capability is disabled: 

» In the 

 

FTP Server Preferences

 

 dialog box, 

 

Server Mode

 

 is set to 

 

Off

 

. Change this 
setting to 

 

On

 

.

» When you attempt to start up FTP, your machine does not respond to the 
FTP command. Check to see if you have configured the FTP server.
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Invoke FTP on the Host

 

Since the remote host initiates FTP transfer, FTP commands vary depending on the 
host system. For full documentation of FTP and commands within FTP, refer to the 
manuals for the host computer. On UNIX systems you can read online documenta-
tion by entering:

 

% 

 

man ftp

 

Issue the FTP Command

 

On most computer systems, at the prompt you enter the FTP command and the IP 
name or IP address of the target machine. 

You can enter the FTP command in one of three ways. Use whichever method you 
are comfortable with. In the following examples of the three procedures, the IP 
name of the Macintosh is 

 

mymachine

 

 and its IP number is 

 

192.17.20.22

 

:

1. Enter either the machine name or IP address and then press RETURN:

 

% 

 

ftp  mymachine

 

     

 

or     

 

% 

 

ftp 192.17.20.22

 

2. Select 

 

Send FTP Command

 

 from the 

 

Network

 

 menu (or press 

 

q

 

-F). Either causes 
NCSA Telnet to enter the FTP command and issue a return character.

3. Enter 

 

ftp, press the SPACEBAR key, select Send IP Number from the Network 
menu (which automatically enters your IP address), and then press RETURN.

Your host computer may not accept FTP commands from any of these procedures, 
so you may have to test some variations to find the easiest method for your site.

Regardless of how you invoke FTP, most FTP clients respond like this:

Connected to 192.17.20.22.
220 Macintosh Resident FTP server, ready
Name (192.17.20.22:uldhmi):

Most FTP clients prompt for your username and password. If you have configured 
the FTP server for passwords (see “Configuring an FTP Server” on page 4–3), then 
you must enter a password. Otherwise, press RETURN to bypass the prompts. If 
you are not prompted for a username and password, assume that you are logged 
on and enter your FTP commands at the FTP prompt.

NOTE: When an FTP connection is active, the cursor changes to a small file icon: 

When the FTP connection terminates, this icon changes back to the standard 
I-beam cursor.

Enter Additional FTP Commands
After FTP is invoked and passwords are checked, most FTP clients prompt you for 
individual FTP commands. These commands are documented in manuals for the 
host computer. Most FTP implementations have similar commands because they 
are modeled after the Berkeley UNIX version of FTP.

Once you are in FTP, you can access online help for a list of available commands. 
FTP commands that are common to most implementations are listed below:

Command Action

ascii Sets mode to ASCII (text) transfer mode, which is the default

binary Sets mode to binary (image or I) transfer mode

cd Changes the directory on your Macintosh
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dir Shows filenames in the Macintosh’s default directory

get filename Gets specified file from the Macintosh and sends it to the host

help Shows an online list of FTP commands

put filename Sends specified file from the host to the Macintosh

pwd Shows the name of the current Macintosh directory

Set the Transfer Mode
ASCII is the default mode for FTP transfers. To transfer graphic or binary data files, 
you must change the transfer mode to binary format before you enter the put or 
get commands that transfer files. To set the transfer mode to binary, enter either 
binary or bin.

If you intend to use the file you are transferring with a Macintosh-specific applica-
tion, you may also need to set MacBinary transfer mode. See “MacBinary Files” on 
page 4–9.

To set or reset the transfer mode to ASCII format, enter ascii.

Examples in “Transferring Files” on page 4–7 demonstrate FTP transactions with an 
ASCII file and with a binary file.

Change the Current Directory
FTP transfers files to the default directory on your Macintosh. To change the direc-
tory, enter cd at the FTP prompt (ftp>).

The cd command (which is one of the common FTP commands) requires you to 
manually specify a directory by entering a pathname; you do not use a dialog box. 
In the directory’s pathname, the Macintosh requires that you enter a colon (:) or 
slash (/) to separate folder names. 

For example, to change the default directory to a directory named myfolder on your 
local Macintosh named hd20, enter one of the following at the FTP prompt: 

ftp> cd ":hd20:myfolder"     or     ftp> cd "/hd20/myfolder"

To identify your default transfer directory, enter the pwd command at the FTP 
prompt. In our example, entering the pwd command after the preceding cd com-
mand results in:

ftp> pwd
"/hd20/myfolder" is the current directory

Transferring Files
Now you are ready to transfer files via FTP.

WARNING:  Do not close an NCSA Telnet connection while a file transfer is in 
progress. Trying to do so causes the file transfer to fail.

To a Macintosh
Even though you seem to be initiating the transfer from the Macintosh, the transac-
tion actually operates from the host. For example, to transfer a file from the host to 
your Macintosh, enter the put command:

ftp> put filename.ext

The following example demonstrates how to use the put command to transfer an 
ASCII (text) file named temp2 from a remote host to a local Macintosh:
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% ftp -n 192.17.20.124
Connected to 192.17.20.124.
220 Macintosh Resident FTP server, ready
ftp> put temp2
200 This space intentionally left blank <  >
150 Opening connection
226 Transfer complete
262145 bytes sent in 32.61 seconds (7.8 Kbytes/s)
ftp> quit
221 Goodbye
%

To a Host
To send a file from your Macintosh to a remote host, enter the get command:

ftp> get filename.ext

The following example demonstrates how to use the get command to transfer a 
binary (image) file named bridge.pic from a local Macintosh to a remote host. 
The cd command is used to locate the directory,  /HD20/pictures, in which the 
file resides.

% ftp -n 192.17.20.124
Connected to 192.17.20.124.
220 Macintosh Resident FTP server, ready
ftp> bin
200 Type set to I, binary transfer mode
ftp> cd "/hd20/pictures"
250 Chdir okay
ftp> get bridge.pic
200 This space intentionally left blank < >
150 Opening connection
226 Transfer complete
262144 bytes received in 9.22 seconds (28 Kbytes/s)
ftp> quit
221 Goodbye
%

To send a text file after this binary (image) file transfer is complete, you must first 
enter ascii to reset the transfer mode to ASCII (text).

Multiple Files
Some versions of FTP let you enter one command (either mput or mget) plus wild-
card characters to transfer multiple files sequentially.

When you use wildcards in FTP get commands, you must enclose the filename in 
quotation marks. For example, enter get "*.image". Do not use quotation marks 
with put commands.

WARNING: If you transfer multiple binary (image) files using a UNIX host, note that 
there is a bug in the mget command as implemented on some systems (especially 
4.2 BSD UNIX systems). When used in binary mode, the mget command adds a car-
riage return to  filenames as they are transferred. The files themselves are not 
affected. Use a UNIX utility to remove the carriage return from the filename. When 
used to transfer multiple ASCII (text) files, the mget command causes no problems.
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MacBinary Files
You may occasionally need to transfer Macintosh-only files (such as applications 
and most data files) to a non-Macintosh host, then download them later without 
losing any Macintosh-specific data (such as icons and creation dates). 

Follow these instructions, and remember that the MacBinary transfer protocol is 
available only when FTP is in binary mode:

1. Select MacBinary Enabled from the File menu. When MacBinary is enabled, all get 
and put commands transfer Macintosh files in MacBinary format. 

You can alternately enable and disable MacBinary by selecting this option from 
the File menu. A checkmark (m) appears next to the command when it is 
enabled.

2. Enter either binary or bin at the FTP prompt to set the file transfer mode to 
binary.

NOTE: If you are writing host-based scripts to download from or upload to a Macin-
tosh in MacBinary mode, enter quote MACB ENABLE to enable MacBinary mode and 
quote MACB DISABLE to disable MacBinary mode.



 

5 Tektronix Graphics

 

This chapter describes the Tektronix 4014 and 4105 graphics emulation capabili-
ties of NCSA Telnet for the Macintosh and explains how to use these graphics win-
dows. Tektronix vector graphics use mathematical descriptions to create images 
primarily as collections of lines.

 

Tektronix 4014 and 4105 Emulation

 

NCSA Telnet can emulate a number of graphical capabilities of Tektronix 4014 and 
4105 terminals, including text modes, text sizing, zoom, and pan. Using Tektronix 
graphics with NCSA Telnet depends on host programs that can produce graphical 
images. When the host programs run and produce Tektronix 4014 or 4105 graphics 
commands, NCSA Telnet automatically switches to graphics mode, opens a graph-
ics window, and does the drawing.

 

Starting a Tektronix Emulation

 

How you set the TEK options in the 

 

Session Configuration Record

 

 dialog box deter-
mines the type of Tektronix emulation, if any, for a given session. In the dialog box 
you can click on one of three TEK options: 

 

Inhibit

 

, 

 

4014

 

, or 

 

4105

 

.

A host program generates the Tektronix clear-screen command sequence (ESC, FF) 
over an open connection. When NCSA Telnet receives this command, a graphics 
window opens. All graphical output from the session is redirected into this window 
until you either close the window or send the 

 

TEK end

 

 command.
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Tektronix-Related Commands in the Session Menu

 

Two Tektronix-related commands appear in NCSA Telnet’s 

 

Session

 

 menu:

 

TEK Page...

 

This command provides a quick way to create a 

 

Tektronix Emulation

 

 win-
dow without intervention from host software. Instead of waiting for 
NCSA Telnet to receive the clear-screen command sequence from the 
host, you can create the window immediately by selecting 

 

TEK Page...

 

.

Just as you would use the PAGE key on a Tektronix keyboard to clear 
the window for the current session, you can select 

 

TEK Page...

 

 to clear a 
graphics window. If a Tektronix window is not open, selecting this 
command creates a cleared graphics window.

 

TEK form feed clears screen

 

When you select this command, NCSA Telnet’s Tektronix emulation 
clears the current Tek window any time it receives a Tektronix clear-
screen command sequence. If this command is not selected, NCSA Tel-
net creates a new window for the new Tektronix image. The session’s 
name and time automatically become the name of each new window.

 

Tektronix Graphics Windows

 

NCSA Telnet lets you detach, delete, zoom and unzoom, copy, resize, and print 
graphics windows.

 

Detaching

 

Detach a graphics window by clicking on the text window for that graphic’s connec-
tion. If you hold down the OPTION key, you can click on a window without detach-
ing the corresponding graphics window. The title of a detached window no longer 
contains the bullet (•) that identifies it as the active output window.

The window can also be detached by host software. When the 

 

CAN

 

 character (dec 
24) is received, the terminal is reset to VT screen emulation.



 

Tektronix Graphics
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Deleting

 

Delete a graphics window by clicking on the close box in the upper-left corner of 
the window’s title bar.

 

Zooming and Unzooming

 

To magnify (

 

zoom

 

 in on) a portion of a drawing in a graphics window, drag a selec-
tion rectangle around the area you want to view more closely. When you release the 
mouse button, the selected section of the drawing expands to fill the entire win-
dow. To prevent distortion or stretching of the TEK image, the magnified selection 
always maintains the same aspect ratio as the TEK window.

To 

 

unzoom

 

 and see the entire drawing, double-click anywhere in the window. 

You can copy and print the contents of both zoomed or unzoomed windows. When 
you copy or print a zoomed window, only the visible portion of the window is cop-
ied or printed.

This screen shows a normal-size 

 

Tektronix Emulation

 

 window with zero magnification:
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This screen shows a portion of the same drawing in zoomed magnification:

 

Copying

 

To copy the contents of a graphics window onto the Macintosh clipboard, activate 
the window by clicking on it, then choose 

 

Copy

 

 from the 

 

Edit

 

 menu. Now you can 
paste the graphic into another Macintosh application.

 

Resizing

 

To resize a graphics window, click and drag the lower-right corner of the window. 
The 

 

Tektronix Emulation

 

 window does not have a grow icon.

 

Printing

 

To print the contents of a graphics window on a local printer or on a remote printer 
on the AppleTalk network, first activate the window by clicking on it and then 
choose 

 

Print Selection

 

 from the 

 

File

 

 menu.

NCSA Telnet centers and scales all graphics to fit the page. To achieve the best pos-
sible resolution on a LaserWriter, in the 

 

Page Setup

 

 dialog box enter 

 

25

 

 as the 

 

Reduce 
or Enlarge

 

 option percentage, as shown in the sample below. 

The 25% setting makes the lines thinner but does not change the size of the image.

For more information about the 

 

Page Setup

 

 dialog box, refer to your Macintosh 
user’s guide.


